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Find out about the extra features of WordWeb Pro, and how to order.

Technical information
Find out how to use WordWeb from other programs.

License information
This program may be freely copied. Read the small print and copyright info 
here.

WordWeb  Web pages are at http://www.wp.com/netword/wweb.html.
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Crossword Compiler for Windows

Crossword Compiler is a powerful crossword writing program that does grid construction, 
word finding, clue writing, desktop-publishing and lots more.

WordWeb Pro has been designed to integrate smoothly with Crossword Compiler. You can 
open the WordWeb window from its Word menu, or you can use it whilst writing clues. 
When you edit a clue, WordWeb displays the synonyms of that word, and you can paste the
word directly into the clue editor. WordWeb Pro comes with a word list of 100,000+ words 
that can be used by Crossword Compiler for grid filling to ensure the grid only contains 
words in the database.

Features of Crossword Compiler include:

Grid editor for puzzles up to 39x39

Word finding and word list manipulation

Automatic grid filling from one of the word lists

Clue editor (with link-up to WordWeb Pro)

Clue database maintenance and look up

Export of puzzles to clipboard and RTF files.

Many printout options

Crossword Compiler costs £28 or $45 US. Alternatively you can get Crossword Compiler and
upgrade to WordWeb Pro for just £35 or $59 US.

Click here for a detailed list of features, or see what current users say about it.

See Ordering in North America or Ordering elsewhere.

If you have an internet connection you should be able to find the latest information about 
Crossword Compiler at http://www.wp.com/netword.

Please mail any questions you may have to the order address, or E-Mail to 
ccw@netword.demon.co.uk.



Crossword Compiler features

WYSIWIG puzzle design editor with two typing directions for puzzles up to 39x39. 
Extensive Undo facility to undo up to the last 2000 letter changes. Block filling to speed 
up puzzle design.
Autofind facility to find words to fit in the puzzle: A list of possible words pops up at a 
single mouse click. Multiple word list searches.
Automatic grid filling to fill in blank crosswords, or to try to find a fit around existing 
letters.
Support for grids with non-rectangular outlines.
Multi-word anagram finder to help writing cryptic clues.
Wild-card word searches to find words matching a given pattern.
Clipboard copying of puzzle, clues, solution, numbered solution, un-numbered puzzle or
answers. Puzzle and solution resizable in host application without loss of quality. 
Clue database. Add clues from puzzles, paste clues in from database, browse database 
and add individual clues.
Automatic symmetry to produce S-Symmetric puzzles, and a double symmetry feature 
to produce even more symmetric puzzles.
Clue editor. Facility to write joint clues, automatic (overrideable) word length. Pop up list 
of anagrams and clues in the database. Support for compound words and phrases. 
Integration with WordWeb (it can use the Windows 95 or Windows 3.1 versions)
Clue review facility to review the clues with answers in scrollable lists, with pop up clue 
editor.
Printout of puzzle, solution, clues and clues with answers. Clues printed word 
wrapped in two columns with number and length of answer.
Customisable square sizes, start-up defaults, page setup, fonts, size ratios and 
more. Multiple configurations and program icons.
Save as Rich Text Format to allow transfer of puzzles between computers without 
copying the program. RTF can also be read from some Macintosh programs.
Facility to add and remove words from word lists, make new word lists and combine 
lists.
Word and compound word lists for between 3 and 20 letters for finding anagrams, 
grid filling and word finding. You can install the lists customised for British or American 
English.
Supports most West-European languages.
Extensive context sensitive help.    
Reference information for cryptic crosswords - an introduction to cryptics and lists 
of letter and anagram indicators.
Customisable headers for professional puzzle submissions.

Optional extras:



Sets of additional word lists    that can be used separately or merged together as 
liked. Including foreign words, expressions, unusual words, various place names and 
words in categories.

System requirements:

386 PC, 3MB+ RAM, Microsoft Windows v 3.1 or higher.



What people say about Crossword Compiler

Here are some quotations from existing users or Crossword Compiler.

'I am finding your crossword program excellent - the best I have used. It has greatly 
speeded and simplified my daily task of creating the Times Two puzzle!'
'1st class program.'
'I congratulate you on this superb application.... I cannot believe its incredible facility of 
use and extraordinarily fast action.'
'Excellent piece of software'
'Absolutely superb!! Well done.'
'This seems like a great program.'
'Brilliant!'
'Thanks for a great programme. This is one of the best shareware programmes I have 
used.'
'Brilliant! I've been looking for this program for 2 years!'
'I haven't found a better program than this'
'...it is a terrific program, and I am very pleased with it.'
'It's simply a great crossword compiler'
'Thankyou for a very innovative programme'
'As a computer professional I am impressed with the quality of your program.'
'Firstly, I've used crossword programs before, but this leaves all others in my experience 
standing! The comprehensiveness and attention to detail are superb. Many thanks!'
'Excellent software'
'This is an incredibly good package - first class'
'Excellent programme, just what I want Thank you!'



License Information

You may use WordWeb free of charge for whatever you like - I hope you enjoy the 
program.
The program is 'bannerware' - I let you use it for free in the hope that you may be 
interested in my other programs Crossword Compiler and WordWeb Pro.

WordWeb may be freely distributed without royalty as long as all the files in the distribution
are copied together unchanged. If you wish to distribute WordWeb on a CD or cover disk 
you are free to do so, but please send a copy to Antony Lewis, 16 Townley Rd, London SE22
8SR, England. 

E-Mail: WordWeb@netword.demon.co.uk
Internet: http://www.wp.com/netword/wweb.html.

WordWeb is copyright © Antony Lewis 1996.
WordNet database copyright © Princeton University. All rights reserved.

THIS SOFTWARE AND DATABASE IS PROVIDED "AS IS" AND PRINCETON    
UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR    
IMPLIED.    BY WAY OF EXAMPLE, BUT NOT LIMITATION, PRINCETON    
UNIVERSITY MAKES NO REPRESENTATIONS OR WARRANTIES OF MERCHANT-    
ABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE    
OF THE LICENSED SOFTWARE, DATABASE OR DOCUMENTATION WILL NOT    
INFRINGE ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR    
OTHER RIGHTS.



WordWeb Pro

WordWeb Pro offers a few extra features for the enthusiast or word puzzler.

Word searching facility
Enter a pattern as the search word and it will find words that match, e.g.

T???SH finds THRASH, THRESH and THRUSH
AP*X finds APEX, APPENDIX and APTERYX
?*Q*P finds ACQUAINTANCESHIP, EQUIP and REEQUIP

Use * to stand for any number of letters, and ? for one unknown letter.

Anagrams
Enter a word and you can find all straight and multiple word anagrams, e.g.

WordWeb Pro finds powder brow + many others
begin finds being, binge, beg in, and gin be.
Great Britain finds (amongst others) arbitrage nit, irritate bang, battering IRA,

arbiter giant,    (changing word order..) trite bargain, a brat 
igniter,

tit bargainer, etc.

Crossword Reference
For people interested in crosswords (especially cryptics) the on-line help has:

introduction to cryptic crosswords
guide to crossword jargon
long list of anagram indicators
long list of letter indicators

WordWeb Pro can also be integrated into Crossword Compiler if you wish to write 
crosswords.

Since you already have the WordWeb database you can upgrade to WordWeb Pro for 
only £10 or $18 US including P&P, which includes a Windows 3.1 and Windows 95 version.
Do not delete your WordWeb database files - the upgrade needs them to run.

Ordering in North America

CREDIT CARD ORDERS ONLY -

You can order with MC, Visa, Amex, or Discover from Public (software)Library by calling 
800-2424-PsL or 713-524-6394 or by FAX to 713-524-6398 or by CIS Email to 71355,470. 
You 
can also mail credit card orders to PsL at P.O.Box 35705, Houston, TX 77235-5705. 

THE ABOVE NUMBERS ARE FOR ORDERS ONLY. 



Any questions about the status of the shipment of the order, refunds, registration options, 
product details, volume discounts, site licenses, etc, must be directed to Antony Lewis, 16 
Townley Rd, London SE22 8SR, UK (E-Mail WordWeb@netword.demon.co.uk).

Ordering elsewhere

Please send a cheque/EuroCheque/money order for £10 with your name and address to 
Antony Lewis, 16 Townley Rd, London SE22 8SR, UK. Please state whether you are running 
Windows 95 or above.

Inquiries by E-Mail can be made to WordWeb@netword.demon.co.uk.
Up to date information about WordWeb Pro can be found on the World Wide Web at 
http://www.wp.com/netword/wordweb.html.



Crossword Compiler Order Form

Please select Print Topic from the file menu and then fill in the form. Send to:
Antony Lewis, 16 Townley Rd, London SE22 8SR, England.

Name:

Address:

Where did you get your copy of WordWeb from?

Please send me the following (put an 'X' for any you want):

             __ Crossword Compiler for Windows for £28

              __ Crossword Compiler + WordWeb Pro upgrade for £35

and the following additional word list sets at £6 each

              __    Disk 1:Medical, legal, ethnic, names, food, US places, UK places, cities, 
literature, 

Old Testament, RAF, IATA, Olympic, school chemistry,
174000+ unusual words and variant spellings.

              __    Disk 2:233000+ Words from Webster's second edition,
75000+ Expressions from Webster's second.

              __    Disk 3:156000+ German, 131000+ French, 85000+ Spanish, 60000+ Italian.

              __    Disk 4:270000+ Finnish, 61000+ Norwegian, 24000+ Danish, 11000+ Swedish.

              __    UK Advanced Cryptics Dictionary: 210000+ words.

I enclose a cheque, Eurocheque or PO/International Money Order for a total of £_____
(please add £2 P&P if you are outside the EEC and £4 if you wish to pay in another currency)

Signed: _____________________________________________________

 Comments, suggestions etc:



Ordering Crossword Compiler in N. America

You can order from M&G Services by check, cash, money order or C.O.D.
The numbers for ordering are 1-800-425-7775 or 1-770-513-6566.
Faxes are also accepted at these numbers.

To order by post please select Print Topic from the File menu and fill in the form below. 

Name: 

Company:

Street:

City: State:

Country: Zip:

Telephone:

Please send me the following:

__ Crossword Compiler for Windows for $45

__ Crossword Compiler + WordWeb Pro upgrade for $59

__ Two disks of additional word lists for $25

Please add $5.00 if you would like to use C.O.D. - US or Canada. 

The additional word lists consist of: unusual words and variant spellings, words from 
Webster's second edition, expressions from Webster's second, medical, legal, ethnic, 
names, food, US places, UK places, cities, literature, Old Testament, RAF, IATA, Olympic and 
school chemistry.

Please make checks payable to: M&G Services
Mail to:
 M&G Services
 1470 Yates Cove
 Lawrenceville, GA 30243
 USA

 Comments,suggestions etc: 



Search Word
Type here the word that you want to look up in the WordWeb database. 
When you have entered the word press Enter, or click on the Search button.



Search Button
Press this button to look up the word in the Search Word edit box.



Show Nouns
Press this button to only show words which are nouns (or press Alt+N). 
If the button is disabled it means there is no sense in which the word is a noun.



Show Verbs
Press this button to only show words which are verbs (or press Alt+V). 
If the button is disabled it means there is no sense in which the word is a verb.



Show Adjectives
Press this button to only show words which are adjectives (or press Alt+A). 
If the button is disabled it means there is no sense in which the word is an adjective.



Show Adverbs
Press this button to only show words which are adverbs (or press Alt+R). 
If the button is disabled it means there is no sense in which the word is an adverb.



Sense descriptions
This box shows the different senses of the word you are looking up.
Different senses are numbered for each word type, nouns first, then verbs,
adjectives and adverbs.

See how to show synonyms by sense.



Showing synonyms by sense

You can filter the synonyms (and all the other related words) to show only ones related to a 
particular sense of the search word: click on the number part of one of the senses. 
Alternatively you can press TAB until the cursor appears in the sense section, use the 
cursor keys to move the cursor onto the sense you want to view, and press ENTER.

For example if the search word is diffuse then your sense list would be

Verb: diffuse
 1. move outward
 2. permeate
 3. as of information

The synonyms include broadcast, disperse, spread out, permeate, etc. To show just 
the senses corresponding to move outward, click on the '1'. You will then only see the 
synonyms    fan out, spread out and spread.

Once the synonyms are restricted to one sense, you can change the sense by using the up 
and down cursor keys. Press ESC to show all senses once again.



Showing synonyms by word type

The four buttons at the side of the synonym list box show whether the search word is a 
noun (N), verb (V), adjective (A) or adverb (R). A button is grayed if the search word does 
not have a meaning of that word type. These are also displayed on the View menu at the 
top of the window.

Click on one of the buttons to show only synonyms of that type, or use Alt+ the letter on 
the relevant button.

To show all the synonyms again (regardless of type) just click on the button again.



Showing related words

The tabs at the bottom of the synonyms list box show the different available types of 
related word. Just click on the a tab to see words of that relationship, e.g. to see the 
antonyms of the search word click on the tab that says Antonyms (if no such tab is present 
it means there are no antonyms in the database). You can also see related words by 
pressing Alt + the underlined letter on the tab.

See Glossary of terms for explanation of the different types of related word.



Glossary of WordWeb terms

Synonyms Words which mean the same in some context
e.g. close is a synonym of shut.

Antonyms Words meaning the opposite in some context
e.g. big is an antonym of little

Attribs A noun for which the adjective expresses value
e.g. big is an attribute of size.

Holonyms X is a holonym of Y if Y is part of X
e.g. forest is a holonym of tree

Hypernym
s

X is a hypernym of Y, if    Y is a kind of X. 
Less specific words.
e.g. vegetation is a hypernym of scrub

Hyponyms X is a hyponym of Y if X is a kind of Y. 
More specific words.
e.g. palace is a hyponym of mansion

Meronym X is a meronym of Y if X is a part of Y
e.g. bumper is a meronym of  car

Similar Words with meanings that are close
e.g. big is similar to huge

Technical Information

WordWeb works through a Windows DLL which you can use from other applications By 
calling procedures in the DLL you can pop up the WordWeb box from other programs.

If you wish to use WordWeb from your wordprocessor, say, you could write a macro to call 
the DLL functions to display the synonyms of the word you have selected in the 
wordprocessor. 

There are two versions of the DLL, one called WORDWEB.DLL for Windows 3.1x, and one 
called WWEB32.DLL for Windows 95+.

I have written interfaces for MS Word 6/7 and Lotus Word Pro 96. Other people have kindly 
send me macros for MS Word 2 and AmiPro. See the Using WordWeb from your word 
processor topic for how to use these. If you write a macro for other programs I would be 
happy to add them to future versions of WordWeb.

For the programmers amongst you, heres what the Borland Pascal/Delphi declarations for 
the DLL API look like in case you want to write your own macros:



function ShowWordWeb(P:PChar; AParent:Integer):integer; {index 1}

Shows WordWeb with P as the search word, AParent as the parent window. If P is nil then 
WordWeb is not initialized with any search word. Returns a handle to the WordWeb window. 
You must have AParent non-zero or retain the return handle. It will then either close when 
you close AParent or, in the second case, you can send it a message to close it.

function ShowModalWordWeb(InP,OutP:PChar; CloseOnCopy:Boolean; 
AParent:Integer): Boolean; {index 2}

Shows WordWeb modally - i.e. it shows the window but waits for the window to close before
returning. InP functions the same as P in ShowWordWeb. OutP points to a buffer to contain
any selected word (the buffer should be 255 bytes long). CloseOnCopy determines 
whether the function returns with the selected word when the user presses the copy 
button. If this is true, pressing Copy closes the window, OutP contains the selected word 
and the function returns true. If WordWeb is closed by pressing Close the function returns 
false.

All the other DLL API functions are reserved for use by Crossword Compiler.

The Boolean and Integer parameters should be 2 bytes if using WORDWEB.DLL, or 4 
bytes if using WWEB32.DLL.



Copy
Press the copy button to copy the selected word to the clipboard. 

If there is selected text in the definition section then that will be copied,
otherwise the word selected in the list box. If you are running WordWeb 
from another program this button may close the window.



Close
Press this button to close the WordWeb window.



Tabs
Click on one of the tabs to show different sets of related words.
See glossary of terms for what the different words on the
tabs mean.



Synonyms list box
This show the synonyms of the search word, or other sets of related 
words indicated on the tabs at the bottom.

Double click on an item in the list to look it up in the database.



History list
Click on this to show the list of words previously searched for. 
You can press the up and down cursors to move quickly up and 
down the list without clicking this button.



Showing related words

WordWeb not only finds synonyms of words, but also a whole host of other words related 
in some way to the search word. The different types of relation are explained in the 
glossary of terms. 

When you first look up a word WordWeb displays the synonyms in the list box in the lower 
half of the window. The other types of related word available are show in the set of tabs at 
the bottom of the list box. Just click on one of these to show the related words of that type.



Using WordWeb

Click on a part of the window to see a description of what it does, or select one of the 
following topics:

Showing synonyms by sense

Showing synonyms by word type

Showing other related words

Note that the window looks slightly different in the Windows 95 version - the tabs are at the 
top of the synonyms box, but the functionality is much the same.



Options

There are three options on the Options menu - select one of them and a tick will appear by 
the menu to show that you have that option selected.

Show roots only

By default WordWeb displays synonyms in the same case as the search word, e.g. if you 
search for hoped then it will display desired, expected, etc. If you select the Show 
roots only option it will display desire, expect, etc. The root of the search word found in 
the database is displayed in the sense descriptions. Select Show roots only to get the 
synonyms as they appear in the database. 

This has some advantage with synonyms of nouns that are more than one word. WordWeb
doesn't know how to pluralize most compounds, so with Show roots only selected it will 
show more synonyms.

Show Hints

Select this option to show pop-up hints when you pause with the mouse over buttons in the
window.

Stay on top

Select this option to make the WordWeb window stay on top of other windows so that you 
can always see it.



AmiPro Macro

Here's a macro to use WordWeb from AmiPro. Copy the text below to use it in AmiPro.
Many thanks to Michael Lee for writing this.

----Copy text below this line----
' Ami Pro macro to call the WordWeb Thesaurus using the current selection as 
the search word.    If the user clicks the copy button from WordWeb, the 
selection made in WordWeb will replace the current selection in Ami Pro and 
will highlight the word.

' Possible Enhancements:
' 1.        Have the macro select a word if one hasn't already been made.
' 2.        If the current selection does not span the word or includes a space, 
adjust the selection to span the word exactly
' Written by Michael Lee (orchid@got.net)

FUNCTION InsertWordWebSynonym()
' Check if a word is selected
' If not selected, signal user and exit macro

IF ( CurShade$() = "" )
                Message( "Please make a selection first.", "WordWeb Thesaurus Macro" )
ELSE
' A word has been selected
' Load WordWeb DLL Function
hShowModalWordWeb = DLLLoadLib( "wordweb.dll", "ShowModalWordWeb", 
"ACCAI" )
' Check if DLL loaded okay
IF( hShowModalWordWeb > 0 )
' DLL is loaded.
' Use current selection to pass to WordWeb
cCurrentSelection = CurShade$()
DEFSTR cReplaceWord;
' Call WordWeb
bResult = DLLCall( hShowModalWordWeb, cCurrentSelection, &cReplaceWord, TRUE, 
0 )
' Insert the replacement word into the current selection if the user selected 
the copy button from WordWeb
' Then, select the newly inserted word.
IF ( bResult = TRUE )
                TYPE( cReplaceWord )                        ' insert the word
                TYPE( "[CtrlShiftLeft]" )                              ' select the word
ENDIF
' Free WordWeb DLL
DLLFreeLib( hShowModalWordWeb )
ENDIF      ' DLL is loaded
ENDIF      ' A selection has been made



END FUNCTION



MS Word 2 macro

Heres a macro to use WordWeb from Word for Windows version 2. You need 
WORDWEB.DLL in your Windows directory to use this macro. You can transfer the macro 
from here to Word by selecting the text below and copying to the clipboard.

To use WordWeb from Word 6 or higher use the WORDWEB.DOT template file supplied.

Many thanks to Andrew Blais for adapting my original Word 6 macro to Word 2.

----Copy text below this line----
Declare Function ShowModalWordWeb Lib "WordWeb.DLL"(In$, Out$, CloseOnCopy
As Integer, AWindow As Integer) As Integer 
Sub MAIN 
On Error Goto IsEnd
CharRight(1, 1) 
I$ = Selection$() 

While Not I$ = " " And Not I$ = "." And Not I$ = "," And Not I$ = "!" And
Not I$ = Chr$(34)
If I$ = Chr$(39) Then Goto Over 
CharLeft(1, 0) 
CharRight(1, 0) 
CharRight(1, 1) 
I$ = Selection$()
Wend 
If I$ = " " Then WordLeft(1, 1) Else WordLeft(2, 1) 
Goto OverOver
Over: 
CharLeft(1, 0) 
Let n = 0 
CharLeft(1, 1) 
I$ = Selection$() 

While Not I$ = Chr$(39) And Not I$ = " "
CharRight(1, 0) 
CharLeft(1, 0) 
CharLeft(1, 1) 
I$ = Selection$() 
Let n = n + 1 
Wend CharRight(n + 1,1) 

OverOver: 
Strl$ = Selection$() 

If ShowModalWordWeb(Strl$, Out$, 1, 0) Then 
EditClear 
Insert Out$ 



End If

IsEnd:

End Sub



Using WordWeb from your word processor

WordWeb can be used directly from some word processors. You just run a macro, which 
pops up WordWeb showing synonyms for the currently selected word in your word 
processor. Pressing Copy then replaces the word with the word you selected in WordWeb. 

Before using any of the macros you need to copy the WWEB32.DLL and/or WORDWEB.DLL 
files (depending on whether you have the Windows 95 or Windows 3.1 versions of 
WordWeb) to your windows directory, probably C:\WINDOWS.

Using WordWeb from MS Word

You can use WordWeb in MS Word version 6 or 7 using the WORDWEB.DOT template 
supplied with WordWeb. To use the template just copy it to your winword\startup 
directory (e.g. c:\msoffice\winword\startup). For use with Word 6 you will need 
WORDWEB.DLL, for use with Word 7 you need WWEB32.DLL in your Windows directory. 

Once you've copied the template, just start Word and click on the button on the WordWeb 
toolbar to show WordWeb.

The same template works with both Word 6 and Word 7. There is also a macro for   MS   
Word 2 which you can use.

Using WordWeb from Lotus WordPro

You can use WordWeb from WordPro by using the WordWeb.LSS LotusScript file supplied 
with WordWeb. To run show WordWeb just select Edit | Script & Macros | Run... and click 
Browse to open the WordWeb.LSS script.    You need WWEB32.DLL to use WordWeb from 
WordPro 96.

If you like you can assign the script to a toolbutton and save the script in your default 
WordPro document so that you can always use WordWeb with the click of a button. See the 
WordPro help for details of how to do this.

Using WordWeb from AmiPro

There is also a macro for AmiPro    




